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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly! We

designed Feather to be a new standard for portable microcontroller cores.
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At the Feather MO's heart is an ATSAMD21G18 ARM Cortex MO processor, clocked at 48 MHz and at 3.3V logic, the
same one used in the new Arduino Zero. This chip has a whopping 256K of FLASH (8x more than the Atmega328 or
32u4) and 32K of RAM (16x as much)! This chip comes with built in USB so it has USB-to-Serial program & debug

capability built in with no need for an FTDI-like chip.
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https://www.adafruit.com/products/2843

To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer batteries and
built in battery charging. You don't need a battery, it will run just fine straight from the micro USB connector. But, if you
do have a battery, you can take it on the go, then plug in the USB to recharge. The Feather will automatically switch
over to USB power when its available. We also tied the battery thru a divider to an analog pin, so you can measure and
monitor the battery voltage to detect when you need a recharge.
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Here's some handy specs!

Measures 2.0" x 0.9" x 0.28" (51Tmm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 4.6 grams

ATSAMD21G18 @ 48MHz with 3.3V logic/power

256KB of FLASH + 32KB of RAM

32.768 KHz crystal for clock generation & RTC

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

PWM outputs on all pins

6 x 12-bit analog inputs

1 x 10-bit analog output (DAC)

Built in 100mA lipoly charger with charging status indicator LED

Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button

The Feather MO Basic Proto has some extra space left over, so we give you a tiny little prototyping area. If you just
need to attach a button or sensor, you may be able to skip out on a breadboard and wire it directly on there.
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Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE. We also
toss in some header so you can solder it in and plug into a solderless breadboard. Lipoly battery and USB cable not
included (but we do have lots of options in the shop if you'd like!)
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Pinouts
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The Feather MO Basic is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll take you a
tour of them now!
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery

USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins

This is the general purpose I/0O pin set for the microcontroller.
All logic is 3.3V

Nearly all pins can do PWM output

All pins can be interrupt inputs

e #0/RX-GPIO #0, also receive (input) pin for Serial1 (hardware UART), also can be analog input

e #1/TX- GPIO #1, also transmit (output) pin for Serial1, also can be analog input

e #20/SDA - GPIO #20, also the 12C (Wire) data pin. There's no pull up on this pin by default so when using with
12C, you may need a 2.2K-10K pullup.

e #21/SCL - GPIO #21, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when using with
12C, you may need a 2.2K-10K pullup.

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-basic-proto Page 9 of 42



e #5-GPIO #5

® #6- GPIO #6

#9 - GPIO #9, also analog input A7. This analog input is connected to a voltage divider for the lipoly battery so

be aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

#10 - GPIO #10

#11 - GPIO #11

#12 - GPIO #12

#13 - GPIO #13 and is connected to the red LED next to the USB jack

AO - This pin is analog /nput AO but is also an analog output due to having a DAC (digital-to-analog converter).

You can set the raw voltage to anything from O to 3.3V, unlike PWM outputs this is a true analog output

A1thru A5 - These are each analog input as well as digital /0 pins.

o SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use them as everyday GPIO pins
(but recommend keeping them free as they are best used for hardware SPI connections for high speed.

Other Pins!

e RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the bootloader manually

e ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage (3.3V) but if
you need an alternative analog reference, connect it to this pin and select the external AREF in your firmware.
Can't go higher than 3.3V!

“proto
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e SWCLK & SWDIO - These pads on the bottom are used to program the chip. They can also be connected to an
SWD debugger.
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use
and configure your Feather

Header Options!
Before you go gung-ho on soldering, there's a few options to consider!
The first option is soldering in plain male headers, this

lets you plug in the Feather into a solderless
breadboard
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https://learn.adafruit.com/assets/30192
https://learn.adafruit.com/assets/30201

Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it
will let you attach featherwings very easily
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https://learn.adafruit.com/assets/30195
https://learn.adafruit.com/assets/30196

We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape
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https://learn.adafruit.com/assets/30197
https://learn.adafruit.com/assets/30198

Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to
plug into a solderless breadboard and plug a
featherwing on top. But its a little bulky

Soldering in Plain Headers
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Prepare the header strip:
+ SamEs snumsEw sasss sssss T Cut the strip to length if necessary. It will be easier to

e solder if you insert it into a breadboard - long pins down
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Add the breakout board:

Place the breakout board over the pins so that the short

~___ pins poke through the breakout pads
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to

Excellent Soldering (https://adafru.it/aTk)).
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! ~ Solder the other strip as well.
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https://learn.adafruit.com/assets/30187
https://learn.adafruit.com/assets/30188
https://learn.adafruit.com/assets/30189

You're done! Check your solder joints visually and
o continue onto the next steps
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Soldering on Female Header

Tape In Place
For sockets you'll want to tape them in place so when

you flip over the board they don't fall out
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https://learn.adafruit.com/assets/30190
https://learn.adafruit.com/assets/30203

Flip & Tack Solder

After flipping over, solder one or two points on each
strip, to 'tack' the header in place
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https://learn.adafruit.com/assets/30204
https://learn.adafruit.com/assets/30205
https://learn.adafruit.com/assets/30206

And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to
Excellent Soldering (https://adafru.it/aTk)).
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https://learn.adafruit.com/assets/30207
https://learn.adafruit.com/assets/30208
https://learn.adafruit.com/assets/30209
http://learn.adafruit.com/adafruit-guide-excellent-soldering

You're done! Check your solder joints visually and
continue onto the next steps

Featper 1@, WiFi e.ﬂ

CATHINC 15880 # |
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Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery. There's two
ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and the Feather will regulate
the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium lon (Lilon) battery
to the JST jack. This will let the Feather run on a rechargable battery. When the USB power is powered, it will
automatically switch over to USB for power, as well as start charging the battery (if attached) at 100mA. This
happens 'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that will only get used
when USB power is lost.

The JST connector polarity is matched to Adafruit LiPoly batteries. Using wrong polarity batteries can destroy

your Feather
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and changeover
diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the Reset button). There's also a
CHG LED, which will light up while the battery is charging. This LED might also flicker if the battery is not connected.

Power supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly JST connector, as
well as USB which is the +5V from USB if connected. We also have the 3V pin which has the output from the 3.3V
regulator. We use a 500mA peak regulator. While you can get 500mA from it, you can't do it continuously from 5V as it
will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi chip or XBee radio though, since the current
draw is 'spikey' & sporadic.

OOOO ) O 3

S 65 SCLSDA
adateutt O-0-0-03.3v
0000000

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell when the
battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for much of the battery life,
then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By measuring the voltage you can quickly
tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a analog #7 A7).
You can read this pin's voltage, then double it, to get the battery voltage.
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#define VBATPIN A7

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.println(measuredvbat);
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ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to Ground and it will
disable the 3V regulator. The BAT and USB pins will still be powered
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be using
version 1.8 or higher for this guide

Arduino IDE Download
https://adafru.it/f1P

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the IDE and navigate
to the Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino menu on OS X

- \
& Blink | Arduino 1.8.2 =

Edit Sketch Tools Help
Mew Ctrl+M
Open... Ctrl+Q
Open Recent L
Sketchbook J [l
Exarnples
Cloze Chrl+W
| Save Ctrl+5
Save As.., Ctrl+5Shift+5
1 Page Setup  Cirl+Shift+P
| Print Ctrl+P
I Preferences  Ctrl+ Comma - Blic domain
Quit Ctrl+Q

A dialog will pop up just like the one shown below.
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http://www.arduino.cc/en/Main/Software

& Preferences

Sketchbook location:

fUsers [todd/Documents fArduino Browse
Editor language: = System Default +  (requires restart of Arduino)
Editor font size: 10 (requires restart of Arduinag)
Show verbose output during: compilation upload
Compiler warnings: None B

Display line numbers
v Verify code after upload
Use external editor
v Check for updates on startup
v/ Update sketch files to new extension on save (.pde -> .ino)

v Save when verifying or uploading
Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

Maore preferences can be edited directly in the file
{Users /todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

OK Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma separated,
and you will only have to add each URL once. New Adafruit boards and updates to existing boards will automatically
be picked up by the Board Manager each time it is opened. The URLs point to index files that the Board Manager uses
to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the Arduino IDE
wiki. We will only need to add one URL to the IDE in this example, but you can add multiple URLS by separating them

with commas. Copy and paste the link below into the Additional Boards Manager URLs option in the Arduino IDE
preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
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C:\UsersYadyada\Dropbox \ArduinaSketches

Editor language: [System Default = (requires restart of Arduinc)

Editor font size: [z ]

Interface scale: V] Automatic | 100 <% (requires restart of Arduino)

Show verbose output during: V] compilation [/ upload |
Compler warmings: [None  + "
|| Cisplay bne numbers 1l
7] Enable Cade Folding

[] Verify code after upload {
7] Use external editor

[¥] Check for updates on startup

[¥] Update sketch files to new extension on save (.pde -> .ina)

[¥] Sawe when verifying or uplog

dioa

Additional Boards Manager URLs:fl https: f/adafruit. com fpackage _adafruit_index.json :
More preferences can be edited arecty n Die e Enter a comma separated list of urls

C:\UsersVadyada\AppDatal ocal\rduino 15\preferences. bt I\
(edit onky when Arduino is not running) \

Here's a short description of each of the Adafruit supplied packages that will be available in the Board Manager when
you add the URL:

e Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.

e Adafruit SAMD Boards - Includes support for Feather MO, Metro MO, Circuit Playground Express, Gemma MO
and Trinket MO

e Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4, Micro and
Leonardo using the arcore project.

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text box separated
by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Now continue to the next step to actually install the board support package!
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https://github.com/rkistner/arcore

Using with Arduino IDE

Since the Feather/Metro/Gemma/Trinket MO use an ATSAMD21 chip running at 48 MHz, you can pretty easily get it
working with the Arduino IDE. Most libraries (including the popular ones like NeoPixels and display) will work with the
MO, especially devices & sensors that use i2c or SPI.

Now that you have added the appropriate URLs to the Arduino IDE preferences in the previous page, you can open
the Boards Manager by navigating to the Tools->Board menu.

[File Edit Sketch [Tools) Help

Auto Format
Archive Sketch
skelth_NOv272 gy Encoding & Reload
1 |void setug Serial Monitor Ctrl+ Shift+M
/7 put ¥ 1
Board: "Arduino/Genuino Uno™ Boards Manager...
a Port Arduino AVR Boards
& void loop( Programmer: "USBtinyISP" ' Arduino Yin
7| /f put § @  Arduino/Genuino Uno

Burn Bootloader

o

[ Arduino Duemilanove or Diecimila

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the window and
select Contributed. You will then be able to select and install the boards supplied by the URLs added to the
prefrences.

Install SAMD Support

First up, install the Arduino SAMD Boards version 1.6.15 or later

You can type Arduino SAMD in the top search bar, then when you see the entry, clickInstall

Arduine SAM Boards (32-bits ARM Cortex-M3) by Arduine version 1.6.6 INSTALLED
Boards included in this package:

Arduino Due.

Onling halp

More infa

m

Arduino SAMD Boards (32-bits ARM Cortex-M0+) by Arduing
Beards included in this package:

Arduino/Genuine Zero.

Online help

M in

162 v [ el

Intel 586 Boards by Intel
Beards included in this package:
Galilea.

Install Adafruit SAMD

Next you can install the Adafruit SAMD package to add the board file definitions
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You can type Adafruit SAMD in the top search bar, then when you see the entry, clickInstall

) Type A « | | Fiter your search...
| Boards incduded in this package:
r Adafruit Flora, Adafruit Gemma BMHz, Adafruit Bluefruit Micro, Adafruit Feather 32u4, Adafruit Metro, Adafruit Pro Trinket
SV LEMHz (USB), Adafruit Pro Trinket 3W/12MHz (USE), Adafruit Pro Trinket SV/16MHz (FTDI), Adafruit Pro Trinket 3V/12MHz
(FTDI). Adafrult Trinkat 8MHz, Adafruit Trinkat 16MHz.
Onling halp
More info

Adafruit SAMD Boards by Adafruit
Boards incduded in this package:
Adafruit Feathar MO.

Onling halp

Mors info

Lesnarde & Micra MIDI-USE [arcore) by Ralf Kistner

Boards included in this package:

Arduino Leanardo (MIDI), Arduino Leonardo [MIDI; iPad compatible), Arduino Micro (MIDI).
Cnling halp

More info

Even though in theory you don't need to - | recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be able to

select and upload to the new boards listed in the Tools->Board menu.

Select the matching board, the current options are:

Feather MO (for use with any Feather MO other than the Express)
Feather MO Express

Metro MO Express

Circuit Playground Express

Gemma MO

Trinket MO

[File Edit Sketch Help

Auto Format CtrlsT
Archive Sketch
waveplayer Fix Encoding & Reload
Serial Monitor Ctrl+Shift+M
F7 Iniciali : .
if ('flash, Serial Plotter Ctrl+Shift+L
5‘-‘-””{-1:: WiFil01 Firmware Updater a
i Adafruit SAMD (32-bits ARM Cortex-hM0+) Boards
} Board: "Adafrutt Metro MO Express” '
Serial .prin R Adafruit Feather K0
Port: "COMI0 (Adafruit Circuit Playground Express)” L) :
Adafruit Feather W0 Express
/7 First ca Get Board Info 3
P @ Adafruit Metro MO Express
| 1 terees U ECTRIE | Adafit Circuit Playground Express
Serial.pe Burn Bootloader ESPE256 Modules

Install Drivers (Windows 7 Only)

When you plug in the board, you'll need to possibly install a driver

Click below to download our Driver Installer
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Download Latest Adafruit Drivers package

https://adafru.it/AON

Download and run the installer

r R
Opening adafruit_drivers.exe u

You have chosen to open:

[n"] adafruit_drivers.exe
which is: Binary File (13.6 MB)

from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

[ Save File ] | Cancel |

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the license

P s
* Adafruit Board Dri\rers:.License Agreement = | —

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

h’his program will allow you to install Windows drivers for -
hardware that Adafruit Industries produces. Please support
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

I
Note you can uninstall any of the installed drivers by using i
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).
- L]

| |
Cancel | Mullsoft Install System +3.0b3 I Agree

Select which drivers you want to install, the defaults will set you up with just about every Adafruit board!

Chedk the board drivers below that you would like to install. Click install to
start the installation.

Select board drivers to install: Feather 32u4, Feather M0, Feather MO Ex
Feather WICED
Trinket / Pro Trinket / Gemma (USBtinyISF)
] Arduine Gemma
] Feather HUZZAH ESP8266 (SiLabs CP210x]
[ Metro 328 / Metro Mini 328 (FTDI YCP and

< »

Cancel | Mullsoft Install System w302, 1 < Back | Install I

Click Install to do the installin'
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,
¥ Adafruit Board Drivers: Completed-LElﬂlg

Show details |

Cancel | Mullsoft Install System v3.0b3 <= Back

Blink

Now you can upload your first blink sketch!

Plug in the Gemma MO, Trinket MO, Metro MO or Feather MO and wait for it to be recognized by the OS (just takes a
few seconds). It will create a serial/COM port, you can now select it from the dropdown, it'll even be 'indicated' as
Trinket/Gemma/Metro/Feather MO!

" - = = 1
sketch_nov23a | Arduino 164 R TSR
File Edit Sketch Elools| Help
Aute Format Cirl+T
Archive Sketch
SKRICh_NOVA3E By Encoding & Reload
void setup() Serial Monitor Ctrl+Shift+M -
// put your
Board: "Adafruit Feather..." g
1l ; Port: "COMS2 (Adafruit ..." ‘ Serial ports
. comw
poid laopdy X Programmer: "AVRISP mkll™ '
/4 put your | ¥ COMS2 (Adafruit Feather MO (Native USB Port))
| Burn Bootloader L _]

I\ ' Tl

Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode(13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.
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If you are having issues, make sure you selected the matching Board in the menu that matches the hardware

you have in your hand.

Sucessful Upload

If you have a successful upload, you'll get a bunch of red text that tells you that the device was found and it was
programmed, verified & reset

»
Adafruit Feather b0 (Native USB Pord) on CO

Compilation Issues

If you get an alert that looks like
Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit SAMD board
packages

ot run program

Truntime o II-None

Adafruit Feather
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Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot
into the bootloader, click the RST button twice (like a double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

| File Edit Sketch Help

Auto Format Ctrd+T
Archive Sketch
T
sketch_novaTs Fix Encoding & Reload
L // the zec Serial Meniter Ctrl+ShiftsM 12 Doard
3 / Board: "Adafruit Feather MO (Mative USB Port)” L3
5|3 b Port L] Senal ports
e Py "USBtimylSP™ ' coMt
: regrammer: i
// the loa ComM12
e Burn Bootloader .
STy e of (- COML29 (Adafruit Feather MO (Native USB Port))
9 digitalWrite (13, HIGH); /f turn the LED on (HIGH is the volvogc Tovoxy
i delay(1000) ; /f wait for & sscond
digitalWrite (13, LOW): /7 turn the LED off by making the voltage LOW

You may need to go back and reselect the 'normal' USB serial port next time you want to use the normal upload.

Ubuntu & Linux Issue Fix

Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an issue with the modem
manager service which causes the Bluefruit LE micro to be difficult to program. If you run into errors like "device or
resource busy", "bad file descriptor", or "port is busy" when attempting to program then you are hitting this issue.

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system. One of these rules is

made to configure modem manager not to touch the Feather board and will fix the programming difficulty issue.
Follow the steps for installing Adafruit's udev rules on this page.
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Adapting Sketches to MO

The ATSAMD?21 is a very nice little chip but its fairly new as Arduino-compatible cores go. Most sketches & libraries will
work but here's a few things we noticed!

The below note are for all MO boards, but not all may apply (e.g. Trinket and Gemma MO do not have ARef so you can
skip the Analog References notel)

Analog References

If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is analogReference(AR_EXTERNAL)
(it's AR_LEXTERNAL not EXTERNAL)

Pin Outputs & Pullups

The old-style way of turning on a pin as an input with a pullup is to use

pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register is the same as the output-selection register.

For the MO, you can't do this anymore! Instead, use

pinMode(pin, INPUT_PULLUP)

which has the benefit of being backwards compatible with AVR.

Serial vs SerialUSB

99.9% of your existing Arduino sketches use Serial.print to debug and give output. For the Official Arduino SAMD/MO
core, this goes to the Serial5 port, which isn't exposed on the Feather. The USB port for the Official Arduino MO core,
is called SerialUSB instead.

In the Adafruit MO Core, we fixed it so that Serial goes to USB when you use a Feather MO so it will automatically work
just fine.

However, on the off chance you are using the official Arduino SAMD core not the Adafruit version (which really, we
recommend you use our version because as you can see it can vary) & you want your Serial prints and reads to use
the USB port, use SerialUSB instead of Serial in your sketch

If you have existing sketches and code and you want them to work with the MO without a huge find-replace, put
#if defined(ARDUINO_SAMD_ZERO) && defined(SERIAL_PORT_USBVIRTUAL)
/I Required for Serial on Zero based boards

#define Serial SERIAL_PORT_USBVIRTUAL
#endif

right above the first function definition in your code. For example:
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{File Edit Sketch Tools Help

datacalc §

ff Simple dace conversions and calculacions

3 #include <Wire.h>
i #inclode "RICLlib.R" |1

& #if defined (ARDUINO_ARCH SAMD)

/f for lero, output cn USB Serial console, remove line below if using programming port to program the Zero!
g ddefine Serial SerialUsB
3 dendif

1 void showDate{conat char* txt, const DateTimes dt) {
Einc (TXC) ;

AnalogWrite / PWM on Feather/Metro MO

After looking through the SAMD?21 datasheet, we've found that some of the options listed in the multiplexer table don't
exist on the specific chip used in the Feather MO.

For all SAMD21 chips, there are two peripherals that can generate PWM signals: The Timer/Counter (TC) and
Timer/Counter for Control Applications (TCC). Each SAMD21 has multiple copies of each, called 'instances'.

Each TC instance has one count register, one control register, and two output channels. Either channel can be enabled
and disabled, and either channel can be inverted. The pins connected to a TC instance can output identical versions of
the same PWM waveform, or complementary waveforms.

Each TCC instance has a single count register, but multiple compare registers and output channels. There are options
for different kinds of waveform, interleaved switching, programmable dead time, and so on.

The biggest members of the SAMD?21 family have five TC instances with two 'waveform output' (WO) channels, and
three TCC instances with eight WO channels:

e TC[0-4],WO[0-1]
e TCC[0-2],WO[0-7]

And those are the ones shown in the datasheet's multiplexer tables.

The SAMD21G used in the Feather MO only has three TC instances with two output channels, and three TCC instances
with eight output channels:

e TC[3-5],WO[0-1]
e TCC[0-2],WO[0-7]

Tracing the signals to the pins broken out on the Feather MO, the following pins can't do PWM at all:
e Analog pin A5

The following pins can be configured for PWM without any signal conflicts as long as the SPI, 12C, and UART pins keep
their protocol functions:

e Digital pins 5, 6, 9, 10, 11, 12, and 13
e Analog pins A3 and A4
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If only the SPI pins keep their protocol functions, you can also do PWM on the following pins:

e TX and SDA (Digital pins 1and 20)

analogWrite() PWM range

On AVR, if you set a pin's PWM with analogWrite(pin, 255) it will turn the pin fully HIGH. On the ARM cortex, it will set it
to be 255/256 so there will be very slim but still-existing pulses-to-OV. If you need the pin to be fully on, add test code
that checks if you are trying to analogWrite(pin, 255) and, instead, does a digitalWrite(pin, HIGH)

Missing header files

there might be code that uses libraries that are not supported by the MO core. For example if you have a line with

#include <util/delay.h>

you'll get an error that says

fatal error: util/delay.h: No such file or directory

#include <util/delay.h>
A

compilation terminated.
Error compiling.

In which case you can simply locate where the line is (the error will give you the file name and line number) and 'wrap
it' with #ifdef's so it looks like:

#if !defined (ARDUINO ARCH SAM) && !defined (ARDUINO ARCH SAMD) && !defined(ESP8266) && !defined(ARDUINO AR
#include <util/delay.h>
#endif

/ | 2

The above will also make sure that header file isn't included for other architectures

If the #include is in the arduino sketch itself, you can try just removing the line.

Bootloader Launching

For most other AVRs, clicking reset while plugged into USB will launch the bootloader manually, the bootloader will
time out after a few seconds. For the MO, you'll need to double click the button. You will see a pulsing red LED to let
you know you're in bootloader mode. Once in that mode, it wont time out! Click reset again if you want to go back to
launching code

Aligned Memory Access

This is a little less likely to happen to you but it happened to me! If you're used to 8-bit platforms, you can do this nice
thing where you can typecast variables around. e.g.

uint8_t mybuffer[4];
float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer might not be aligned to a 2 or 4-
byte boundary. The ARM Cortex-MO can only directly access data on 16-bit boundaries (every 2 or 4 bytes). Trying to
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access an odd-boundary byte (on a 1 or 3 byte location) will cause a Hard Fault and stop the MCU. Thankfully, there's
an easy work around ... just use memcpy!

uint8_t mybuffer[4];

float f;
memcpy(f, mybuffer, 4)

Floating Point Conversion

Like the AVR Arduinos, the MO library does not have full support for converting floating point numbers to ASCII strings.
Functions like sprintf will not convert floating point. Fortunately, the standard AVR-LIBC library includes the dtostrf
function which can handle the conversion for you.

Unfortunately, the MO run-time library does not have dtostrf. You may see some references to using #include
<avr/dtostrf.h> to get dtostrf in your code. And while it will compile, it does not work.

Instead, check out this thread to find a working dtostrf function you can include in your code:
http://forum.arduino.cc/index.php?topic=368720.0

How Much RAM Available?

The ATSAMD21G18 has 32K of RAM, but you still might need to track it for some reason. You can do so with this handy
function:

extern "C" char *sbrk(int i);

int FreeRam () {

char stack dummy = 0;

return &stack dummy - sbrk(0);
}

Thx to http://forum.arduino.cc/index.php?topic=365830.msg2542879#msg2542879 for the tip!

Storing data in FLASH

If you're used to AVR, you've probably used PROGMEM to let the compiler know you'd like to put a variable or string in
flash memory to save on RAM. On the ARM, its a little easier, simply add const before the variable name:

const char str[] = "My very long string";

That string is now in FLASH. You can manipulate the string just like RAM data, the compiler will automatically read from
FLASH so you dont need special progmem-knowledgeable functions.

You can verify where data is stored by printing out the address:
Serial.print("Address of str $"); Serial.printin((int)&str, HEX);

If the address is $2000000 or larger, its in SRAM. If the address is between $0000 and $3FFFF Then it is in FLASH
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Feather HELP!

My Feather stopped working when | unplugged the USB!

A lot of our example sketches have a

while (!Serial);

line in setup(), to keep the board waiting until the USB is opened. This makes it a lot easier to debug a program
because you get to see all the USB data output. If you want to run your Feather without USB connectivity, delete or
comment out that line

My Feather never shows up as a COM or Serial port in the Arduino IDE

A vast number of Feather 'failures' are due to charge-only USB cables

We get upwards of 5 complaints a day that turn out to be due to charge-only cables!

Use only a cable that you know is for data syncing

If you have any charge-only cables, cut them in half throw them out. We are serious! They tend to be low quality in
general, and will only confuse you and others later, just get a good data+charge USB cable

Ack! | "did something" and now when I plug in the Feather, it doesn't show up as a device anymore so | cant upload
to it or fix it...

No problem! You can 'repair' a bad code upload easily. Note that this can happen if you set a watchdog timer or
sleep mode that stops USB, or any sketch that 'crashes' your Feather

1.
2
3.
4

o o

Turn on verbose upload in the Arduino IDE preferences

. Plug in feather 32u4/MO, it won't show up as a COM/serial port that's ok

Open up the Blink example (Examples->Basics->Blink)

. Select the correct board in the Tools menu, e.g. Feather 32u4 or Feather MO (check your board to make sure

you have the right one selected!)

Compile it (make sure that works)

Click Upload to attempt to upload the code

The IDE will print out a bunch of COM Ports as it tries to upload. During this time, double-click the reset
button, you'll see the red pulsing LED that tells you its now in bootloading mode

The Feather will show up as the Bootloader COM/Serial port

The IDE should see the bootloader COM/Serial port and upload properly
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&5 Blink | Arduino 165 = B S|

| File Edit Sketch Tools Help

Arduing Leonarde on COMIZ

| can't get the Feather USB device to show up - | get "USB Device Malfunctioning" errors!
This seems to happen when people select the wrong board from the Arduino Boards menu.

If you have a Feather 32u4 (look on the board to read what it is you have) Make sure you select Feather 32u4 for
ATMega32u4 based boards! Do not use anything else, do not use the 32u4 breakout board line.

If you have a Feather MO (look on the board to read what it is you have) Make sure you select Feather MO - do not
use 32u4 or Arduino Zero

I'm having problems with COM ports and my Feather 32u4/MO
Theres two COM ports you can have with the 32u4/MO, one is the user port and one is the bootloader port. They
are not the same COM port number!

When you upload a new user program it will come up with a user com port, particularly if you use Serial in your user
program.

If you crash your user program, or have a program that halts or otherwise fails, the user com port can disappear.
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When the user COM port disappears, Arduino will not be able to automatically start the bootloader and upload
new software.

So you will need to help it by performing the click-during upload procedure to re-start the bootloader, and upload
something that is known working like "Blink"

| don't understand why the COM port disappears, this does not happen on my Arduino UNO!
UNO-type Arduinos have a seperate serial port chip (aka "FTDI chip" or "Prolific PL2303" etc etc) which handles all
serial port capability seperately than the main chip. This way if the main chip fails, you can always use the COM port.

MO and 32u4-based Arduinos do not have a seperate chip, instead the main processor performs this task for you. It
allows for a lower cost, higher power setup...but requires a little more effort since you will need to 'kick' into the
bootloader manually once in a while

I'm trying to upload to my 32u4, getting "avrdude: butterfly_recv(): programmer is not responding" errors

This is likely because the bootloader is not kicking in and you are accidentally trying to upload to the wrong COM
port

The best solution is what is detailed above: manually upload Blink or a similar working sketch by hand by manually
launching the bootloader

I'm trying to upload to my Feather MO, and | get this error "Connecting to programmer: .avrdude: butterfly_recv():
programmer is not responding"

You probably don't have Feather MO selected in the boards drop-down. Make sure you selected Feather MO.

I'm trying to upload to my Feather and i get this error "avrdude: ser_recv(): programmer is not responding"

You probably don't have Feather MO / Feather 32u4 selected in the boards drop-down. Make sure you selected
Feather MO (or Feather 32u4).

| attached some wings to my Feather and now | can't read the battery voltage!
Make sure your Wing doesn't use pin #9 which is the analog sense for the lipo battery!
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Downloads
Datasheets

e ATSAMD21 Datasheet (the main chip on the Feather MO)
® Fritzing object in the Adafruit Fritzing Library

® EagleCAD PCB files in GitHub

Feather MO Basic Proto Pinout Diagram

Firmware

https://adafru.it/z3f

Feather MO Bootloader - You'll need to program it in using an ST-Link, JLink or other SWD-capable programmer.HEX

available in the github repo

Schematic

Click to enlarge
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